
WIR i-Star Professional Edition Tutorial No. 2 [Revision 4] 2010-01-01

For Use With:

WIR i-Star Professional Edition 
Fully-Enabled Free Public Beta – Version 7.2 (2010-01-01)

WIR i-Star Professional Tutorial No. 2

“Light Fading of Inkjet Prints”

Powerful CIELAB based, full tonal scale, comparative image analysis software with sim-
plified single-number or two-number reporting of results.  Developed by Wilhelm Imaging 
Research, WIR i-Star also provides comprehensive analysis of image appearance differ-
ences with specific colors, including critical human skintone colors, or with user-selected 
pictorial “regions of interest,” in both color and black-and-white photographic images.



WIR Software Development and Documentation Team:
Dmitriy Shklyarov (chief programmer), Yaw Nti-Addae, Kabenla Armah, 
Mark McCormick-Goodhart (consultant), Dimitar Tasev, Henry Wilhelm, 

Tessa Bergan (editor), and Carol Brower Wilhelm 

© Copyright 2008 Wilhelm Imaging Research, Inc.
All Rights Reserved

Wilhelm Imaging Research, Inc.
Grinnell, Iowa  U.S.A.

istarcolor@gmail.com

www.wilhelm-research.com



1Light Fading of Inkjet Prints

Light Fading Tutorial Tutorial 2 (Rev. 2010-01-01)

Tutorial Two:

Light Fading of 
Inkjet Prints

For this project use a pictorial target – an image down-sampled to 30X39 
pixels, printed on glossy paper using dye-based ink.  The samples will be ex-
posed to 35kLux fluorescent light 24 hours a day, in a protected environment at 
temperature of 23˚C.  All samples have the same dimensions.  The “Examples 
Folder” contains i-Star screen captures of the initial target and necessary data 
to follow this example.  The purpose of this project is to analyze and quantify 
the loss in quality of the print as a result of exposure to a light source. 

Initially, collect the necessary data using an appropriate tool.  The spectral 
data supplied in the Examples folder has been collected using Gretag Macbeth 
Spectrochart Lite software and Gretag Macbeth Spectrolino spectrophotom-
eters.  Because the spectral data is supplied, instructions for data collection are 
omitted.  Guidance for data collection can be found in instrument or software 
manuals.

Now, begin the project.

Start i-Star
Create a new project.

Press Ctrl + n or choose “New Project” in the “Project” menu.  A request  
for a reference measurement will appear.  This measurement is considered 
the “ideal” or starting point.  In this case, choose the reference measurement 
marked “_000.”  This file and the remainder of the files related to the project 
are available in the “Pictorial Light-fading Example” sub-folder in the “Ex-
amples” folder on the install disk.  See (Fig.1).

Fig. 1
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Choose “sn15690_mn000_ms.xls” in the open file dialog. 

i-Star will process and report the file on the “Data Layout” page.  A warn-
ing will appear requiring specific information.  See (Fig. 2).

This warning means the data collecting software did not report the num-
ber of columns and rows in the output file.  Fill in the “Number of Rows” 
and “Number of Columns” fields.  See (Fig. 3).  The originating data targets 
contain 39 rows and 30 columns each.  The target reading sequence is top-to-
bottom.

Enter the number of rows and columns in the appropriate fields.
Select “top-to-bottom” in the Reading Sequence radio group.
Press “Proceed” button.

i-Star will interpret the data contained in the file and evaluate the param-
eters for all predefined regions of interest.  Unless the option is disabled, a 
message to check (and possibly reassign) the color map values of the target 
will appear.  See (Fig. 4).

Fig. 2

Fig. 3
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The color map values may be changed on the “Project Color Map” tab of 
the “Preferences” page.

Press F2 or choose “Preferences” in the i-Star menu.
Navigate to “Project Color Map” tab.

i-Star has several ways of interpreting extreme values of L.  Ideally, on 
images representing the entire L band, readings of L values range between 0 
and 100.  In reality, only values close to these are achievable.  The first option, 
“Defined by user,” allows manual setting of these values reasonable for the 
test.  “Defined by image,” will analyze the image and assign values automati-
cally.  Finally, “Defined by map,” analyzes a percentage of patches from the 
target for each L extreme and computes a mean value.  Depending on prefer-
ences and the necessity for repetition of the test, choose one setting.  Keep 
in mind, only the first and last choices offer a basis for cross-examination of 
projects.

In this example, use the “Defined by map” option and calculate the Lmin 
and Lmax values from the first percentile of extreme L values.

Fig. 4

Fig. 5
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Choose “Defined by map” for both black and white patches. 
Click “Mark Extreme” button for a value of 1%.
Apply changes. 

Because the remaining files have the same geometry as the initial file, ac-
tivate the Data Import Assumptions (DIA) engine.  Make note, though, that 
the default selection of the DIA engine is the left-to-right reading sequence.  
In this example, mark this option in the Sequence Assumption radio group.  
The DIA engine will make assumptions about the size and measuring pa-
rameters of the “import to” targets based on the reference file for the i-Star 
project.  Consequently, before employing  DIA, verify that the data is compat-
ible.  Data may not be compatible if it was gathered using different measuring 
devices or software.  The check boxes in the “Data import options” section 
will assist in verifying that the data meets the necessary criteria for accurate 
comparison.  See (Fig. 6).

Navigate to “Data import options” sub-tab on the “General” tab.
Activate all assumptions and select the sequence of patches for top-to-bot-

tom.
Deactivate “Import only user confirmed data” option. 

Activation of the “Import only user confirmed data” option allows for ad-
ditional modifications from the “Data Layout” page after the completion of 
the DIA engine cycle. 

Fig. 6
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Next, test specific information is adjusted.  As mentioned earlier, the sam-
ples were exposed to 35kLux fluorescent light for 24 hours a day in a pro-
tected environment at a temperature of 23˚C.  Adjust this information on the 
“Permanence” tab.  See (Fig. 7).  

Navigate to “Permanence” tab.
In the “Test Conditions” group box enter 35000 for the Light level value, 

23 for the temperature, 50 for the humidity, and leave the remainder of values 
unchanged.

There is no need to change the Light cycle value for this project because 
the samples were exposed to light 24 hours a day.  The default values in the 
“Predictions for” box indicate the expected exposure is 450Lux of light 12 
hours a day in normal conditions.  

Next, specify more project information.  For this example, use the dummy 
data.  See (Fig. 8).  Real data in subsequent tests will provide future refer-
ence.  

Navigate to “Project Info” tab.
Enter “My Spectrometer” for output device, “Some Ink” for ink set, “Some 

Paper” for media, and “High Intensity Halogen Light” for the test condition 
value.

Fig. 7
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Additional data and other project specifics may be included.  Examples of 
such notes may include abnormalities related to the test (e.g. light intensity 
and temperature fluctuations), side effects to the ink set or the printing me-
dium (e.g. ink bleeding or granulation, aberrations and changes of the printing 
medium, etc.), and any other important project details.

Return to “Project Description” page.
Press F2 or choose “Preferences” in the i-Star menu.

Because i-Star calculates results based on the parameters set on the “Pref-
erences” page, any data-related parameter change requires a recalculation.  
Because the color map was modified, recalculate the averaged data for the 
project.  See (Fig. 9).

Press F7 or select “Recalculate Project” in “Project” menu. 

A recalculation completion notice will appear.

Fig. 8

Fig. 9
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Press Ctrl + a or choose “Add to Project” in the “File” menu.
Choose “sn15690_mn001_ms.xls” in the open file dialog. 

i-Star will process the file and report on the “Data Layout” page.  Return to 
the “Project Description” page.

Numerically add the remaining project files into the folder.

Enter the timer values for these measurements on the i-Star “Project De-
scription” page.  All data was collected on 168 hour intervals.  See (Fig. 10). 

 
Navigate to “Project Description” tab of the Main i-Star window.
Enter 168 in the second through seventh rows of the “Timer Stopped” col-

umn.

Fig. 10

Now that all files have been imported for this project, the data is ready for 
analysis.  Before analysis, check the “Target Model” window.  This window 
shows the visual representation of imported data and must look exactly like 
the target used for collecting the data.  See (Fig. 11).

Press Ctrl + t, or select “Target Model Window” in “View” menu.
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The target window now shows the reference target, i.e. the original mea-
surement of the print.  This window offers a number of controls all described 
in the i-Star User Guide.  The first control changes the file (and the corre-
sponding target) represented by the image on the screen. 

View the target model corresponding with the last print in the series.

Select “sn15690_mn006_ms.xls” in the first drop down list.

The second drop down list changes the region of interest/custom crop rep-
resented in the “Target Model” window.  View the “General Skintones” re-
gion.

Select “sn15690_mn000_ms.xls” in the first drop down list.
Select “General Skintones“ in the second drop down list.

The grid on the “Target Model” window may be turned on or off at any 
time.  To toggle the appearance of the grid, press “g.”  Change the view to 
the last measurement and a direct comparison of the skin tone patches from 
before and after the test will appear.  See (Fig. 12 & 13).

Fig. 11
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Press g.
Select “sn15690_mn006_ms.xls” in the first drop down list.

Fig. 12

Fig. 13
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Now that all data has been imported, close the “Target Model” window.  In 
some instances, the “Target Model” window will be opened much sooner.  For 
example, data sets imported from multiple measuring systems and associated 
software will require the “Target Model” window.

Press g.
Close the “Target Model” window.

Next, consider the project charts.  i-Star provides a number of easy chart-
ing options which may include spectral and hue angle distributions, i-Star 
component development and results, tonal reproduction charts, and compo-
nent histograms.  Custom specifications of the charts is possible, so becoming 
familiar with the manual factor entries will lead to greater efficiency.  The 
“Chart” window consists of a single page with the “Settings” and “Chart” 
tabs.  The “Chart” tab contains the chart and a lower panel with controls.  
Right-click any unused surface on the lower panel to access the chart selec-
tion menu which contain choices for all available charts.  The “Settings” tab 
contains all controls for the appearance of charts.  The individual group box 
titles indicate settings for the charts.

Press Ctrl + g or choose “Charts Window” from the “View” menu.

Fig. 14
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The chart window will allow easy interpretation of both measurement and 
trend lines.  See (Fig. 15).  Click on each data point and the status bar will 
show the corresponding file and x,y coordinates.

Take a moment to observe the changes indicated by the chart: the final 
Contrast Factor full is 85.298 and the Brightness Factor full is at 93.339; I* 
full is 58.719, I*tone 79.775, and I*color full is 32.828.  Additionally, there 
are 0.290% falsely encoded patches according to I*tone and 7.863% accord-
ing to I*color.

This project considers change in I*total, I*tone, I*color, Δe2000, hue an-
gles, and L values.  The regions of interest include the complete data set, neu-
trals, and near neutrals.  Additionally, evaluation of differences between the 
patches with Lmax and Lmin will occur.  See (Fig. 14).

Navigate to “Settings” tab.
In the “I* Component Results and Averaged Parameter Development” 

check the boxes for I*total, I*tone full, I*color full, Quality Control for both 
I*tone and I*color, Brightness Factor full, and Contrast Factor full.

Navigate to “Chart” tab.  Check “Show legend” box.
Choose “Display Time (Yrs)” in the x axis group box.

Fig. 15
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The final Contrast Factor full is 78.514 and the Brightness Factor full is 
at 93.339; I* full is 59.817, I*tone 72.749, and I*color full is 34.498.  Ad-
ditionally, there are 0.885% falsely encoded patches according to I*tone and 
19.469% according to I*color.  This indicates that the skin tones have deterio-
rated significantly, and as much as 19.469% of the patches have a hue angle 
shift greater than 60º in the LAB color space.  See (Fig. 16).

These results suggests a check of the spectral distributions for some skin 
tone patches.  Use the spectral distribution charts in i-Star to  analyze  how 
one of the “background” patches changed.  

Right-click on the panel and select “Spectral Distribution” in “Context” 
menu.

Change the column value to 15 and the row value to 37.

The tricolor chart displays overall spectral response of the target.  See (Fig. 
17).  Lower wavelengths represent the shades of blue and violet.  The center 
wavelengths represent greens, cyans and yellows.  The higher wavelengths 
represent the oranges and reds.  Observe the chart and evaluate the changes.

i-Star may also analyze data for any chosen color space region of interest.  
Consider the region of “Skin Tones” as defined in the template.

Select “General Skintones” in the Regions of Interest drop down list.

Fig. 16
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Experiment with other row/column values and observe the spectral distri-
bution changes.

Another important feature of i-Star is its ability to analyze and report the 
Δe values.  By default, all Δe values are calculated and presented on the cor-
responding tabs for each patch of the target measurements.  This is, however, 
not sufficient sometimes, instead an overall value or histogram allows a better 
analysis of the results.  Observe the Δe histograms for all patches of the target, 
in increments of five, for the value of Δe2000.

Right-click on the panel and select “Component Histogram” in “Context” 
menu.

Select “General Skin tones” in the “Region of interest” group box, and 
∆E2000 in the “Components” group box and check “Use complete region,” 
and choose a step interval of “5.”  See (Fig. 18).

Fig. 17
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The Component Development chart summarizes average Δe2000 values.

Right-click on the panel and select “Component Development” in the con-
text menu.  See (Fig. 19).

Fig. 18

Fig. 19
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Finally, save the project.  This allows access to data easily without having 
to reenter any information.  i-Star will save the complete set of data, a snap-
shot of the settings, and the results of all calculations.  Please note that i-Star 
will not save any open windows or generated graphs, so export either of these 
items before closing the windows.

Although i-Star saves all project data entered in the application, as a fur-
ther safeguard against data loss, keep the original source files and periodically 
back up all i-Star projects.

Press Ctrl + s or select “Save Project” in the “Project“ menu.
Choose a filename for the project. 
Click “Save” button.  See (Fig. 20).

Fig. 20

WIR i-Star contains a custom report creation utility, allowing the creation 
of PDF reports for analyzed data.  This tutorial shows the steps taken to create 
a standard WIR report using the i-Star application.

Click on “PDF Report Preview Window” under “View” menu.



16Light Fading of Inkjet Prints

Light Fading Tutorial Tutorial 2 (Rev. 2010-01-01)

The Summary page of the PDF Report Preview window will appear.  The 
first page on the PDF will contain a summary of the project details.  The file-
name text box displays the name of the PDF.  Choose a name suitable for the 
project.  In this example, name the PDF ‘Lightfading_report_2007_12_13.
pdf.’  The remaining three check boxes and corresponding text boxes desig-
nate the location of the PDF file.  For this example, place the PDF in the same 
folder as the project.  Check the ‘at project folder’ check box.  The remain-
ing entries, colored white, must be filled from the ‘Preferences’ page under 
the ‘Project Info’ tab.  These fields are not required, but provide more detail 
about the nature of the project.  All fields (text boxes) that are yellow in color 
may be directly modified from the PDF Report page.  Be sure the ‘Wilhelm 
Imaging style (short)’ radio button is checked.  This is the reporting format of 
a standard Wilhelm Imaging Research report.

The check boxes on the right side of the PDF Report Preview show which 
pages are included in the current ‘Report Preset’ selection (in this case ‘Wil-
helm Imaging style short).  The buttons to the right of the check boxes al-
low you to preview the pages before printing the PDF.  A green label on the 
button indicates that you are currently viewing the page represented by that 
button.  In order to view a particular page, the corresponding check box must 
be checked (i.e. that page must be included in the PDF report).  Click each to 
view the PDF page. 

After reviewing the PDF preview, click the ‘Create PDF Report’ button to 
print the PDF. 

Continue exploring i-Star.  Explanations of remaining controls, including 
those for the main settings page, are available in the i-Star User Guide.  When 
finished, press Ctrl + q or choose “Quit” in the “i-Star” menu.  Save any ad-
ditional changes made to the project.


